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Welcome to TestCenter! 

 

TestCenter is an online application for Test Management. It will support any type of test project or 

process where you want a structured method of validating requirements against TestCases. 

Typically this would be a product development project of any sort, but it could also be any other type 

of validation process. It doesn’t matter if the project is a software or hardware development project. It 

doesn’t matter what project methodology you use (waterfall, agile, etc.). What is important is if you 

want to work in a structured manner with your validation process. 

TestCenter gives you a highly efficient and easy to use platform for creating, storing and in other ways 

administrating all core test artefacts, like Requirements, TestCases and TestRuns, etc. as well as 

executing tests and reporting test result. It also helps you keep track of all test resources you need. So 

the focus is really on the very core test information. 

The idea behind TestCenter is that it shall be a very efficient and easy-and-to-use tool. The user 

interface is designed so that data is presented and can be manipulated with a minimum of a mouse or 

keyboard clicks. Also, we want you to get an overview of data at the same time you see the details. 

In order to reach this great efficiently and ease of use, the user interface is very consistent for most 

operations. TestCenter is very focused around what we believe is core functionality related to just test 

management. It is not intended for project management or task management in general, nor is it a 

bug tracking or issue tracking system. We believe there many other great tools for these purposes and 

likely you already have your preferred choice for this. We want TestCenter to be a good companion to 

such tools, rather that replacing them. 

Thanks for joining the TestCenter user group. Hope you will enjoy the tool. Don’t hesitate to give us 

feedback at info@testcenter.one. Please visit us at www.testcenter.one. 

Magnus Wennerbeck, TestCenter founder 

mailto:info@testcenter.one
http://www.testcenter.one/
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1 Introduction 

TestCenter is an online tool for efficient management of test projects. The system manages six types 

of test artefacts and the relationship between these. See picture below. 

 

Figure 1. Test artefacts crosswise related in multiple directions 

Requirements define the product or what the projects shall result in. Requirements can be of any type; 

functional, appearance, physical, performance or any other characteristic that shall be validated. 

TestCases is an instruction of how the validation of a Requirement is performed. Often we use several 

TestCase to validate a specific Requirement. A TestCase can be used for several Requirements. 

TestRuns are a collection of TestCases planned to be executed in a single test session.  

Releases represent the test object, like the product or the project outcome. It can be the full product 

or part of it. Releases can be directly related to requirements for an exact definition of its content. 

Resources represent what is needed to be able to execute TestCases. A resource can be almost 

anything; an instrument, equipment, computer, some specific software, a specific set of test data or 

whatever else you would need for being able to execute the TestCase. It can also be seen as 

‘prerequisites’ for executing the TestCase. Also, resources is an important  

Testbeds represents a group of resources that are needed for a specific test situation. Some projects 

may have several test facilities; i.e. one for software testing, another for hardware testing, yet another 

for environment testing. This way you can easily keep records of each test facility’s needed inventory. 
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2 Getting started 

2.1 TestCenter User Interface 

 

The User Interface is consistent for most type of user operations. Principally, we have a left side 

representing the primary data we want to work with, and a right side which represents the secondary 

data.  

The left and right side together give a quick understanding of how various data records are related to 

each other. 

The User Interface is in 5 areas: 

 Grid 1 shows all records of the primary data. 

 Grid 2 show records of secondary data that are linked the selected record on left side. 

 Grid 3 show all records of secondary data that is not linked to the selected record on left side. 

 Form 1 is used for presenting and editing record details for the selected row in grid 1. 

 Form 2 is used for presenting and editing record details for selected row in grid 2 or grid 3. 

 

The grids are used for presenting data overview and selecting individual records. It is not used for 

editing data.  

Above each grid, there is a panel of controls, for functions on the selected row in the grid. 

 

Form 1 

Grid 1 

Grid 3 

Grid 2 

Form 2 
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2.2 Menu bar 

  … 

On top of the application window is a menu bar with a number of functions. See figure above. 

Leftmost is the name of the current project (TestCenter).  

2.2.1 Project menu 

The Project menu presents a list of all project that the user has access to. Just click on the project you 

want to work with. 

There is also a function ‘Project Management’ for managing projects; renaming, deleting, sharing, etc. 

See more about this in section Project Management. 

2.2.2 Options menu 

The Option menu is for setting a number of usage related options 

2.2.3 Tools menu 

The Tools menu is for various functions: 

2.2.4 Show menu 

The Show menu is for selecting what areas of the application windows you 

want to show.  

2.2.5 View selection 

Right of the menus, there are six clickable labels for selecting a functional view. See more about views 

in section 2.5 below. 

2.2.6 Subscription information 

On the right side of the menu bar, there is information on the remaining time for the subscription. 

2.2.7 Logout 

Rightmost of the menu bar there is a link for logging out from the application. 

2.3 Message bar 

 

Under the top menu bar, there is message bar for information to the user. Error messages are 

indicated by red backcolor. 
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2.4 Forms for record details 

 

The form above grid 1 and grid 2 are used of for presenting and editing properties of the record 

selected in the grids. There are three types of data controls: 

 Textbox - You can enter data directly into the textbox. 

 Droplist – The control allows for both manual text editing and selecting from a list of values. 

The droplist controls don't have any predefined values. You can write new values directly into 

the control. Once entered values is stored in the system and can be selected for further us.  

 Date selector – you pick a date from a calendar. 

2.4.1 Standard properties 

All test artefacts (data records) have the same set of basic properties: 

 PID (Position ID) is used for enumerating the record. You can use number or text. 

 Title is a short heading  

 Description is a more exploratory text describing in the record 

 Comment is used to give additional information, like side notes, to the record  

 Type is a property used for categorising the record 

 Priority is a property used for categorising the record 

 Responsible is a 

 Status is a 

 Tag is a free text field which you can use for an extra dimension of relating items together. 

Then, some test artefacts have additional properties 

Properties not being used can then be left without any value. 

2.5 Grid panel controls 

Above each grid is a panel of controls (buttons and checkboxes) to be used in combination with the 

selected data in the grid. Exactly what controls depend on which view is selected and on the actual 

state for the record. See more details in respective view in section 4. 

Leftmost is a label showing the number of records in the grid. 

If a function is not allowed or applicable on the selected record, the control is disabled. 



TestCenter User Manual  2017-03-14     v0.81 

page 8 (20) 
 

2.5.1 Grid 1 controls 

 

Standard controls (buttons or checkboxes) for grid 1, common for all views are: 

 Refresh – reloads data from database 

 Delete – used to delete records 

 Create new – used for creating new records 

 Copy to new – copies the 

 Multiselect (checkbox) – used when you want to select several rows in the grid 

For some views, more controls are for specific purposes. See more in a later section in the manual. 

2.5.2 Grid 2 controls 

 

Standard controls for grid 2, common for all views are: 

 Unlink – used to disconnect the selected record from the selected record in grid 1 

 Refresh 

 Multiselect 

For some views, more controls are for specific purposes. See more in a later section in the manual. 

2.5.3 Grid 3 controls 

 

Standard controls for grid 3, common for all views are: 

 Link – used to connect the selected record to the selected record in grid 1 

 Refresh – reloads data from database 

 Delete – used to delete records 

 Create new – used for creating new records 

 Copy to new – copies the 

 Multiselect (checkbox) – used when you want to select several rows in the grid 

For some views, more controls are for specific purposes. See more in a later section in the manual. 

2.6 Views 

View is the term used to indicate what we want to see as primary data. We have six view alternatives:  
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 Requirements 

 TestCases 

 TestRuns 

 Releases 

 Resources 

 Testbeds 

The left side is consistently used for working with primary data. The right side is used to work with 

secondary data and to manage relations between secondary and primary data. For each of the six 

views, you have a number of options for what you want to see as secondary data. Following 

combination of primary and secondary data are possible: 

 Requirements 

o Requirements vs. TestCases (*) 

o Requirements vs. TestRuns 

o Requirements vs. Releases (*) 

 TestCases 

o TestCases vs. Requirements (*) 

o TestCases vs. TestRuns (*) 

o TestCases vs. Resources  (*) 

 TestRuns 

o TestRuns vs. TestCase (*) 

o TestRuns vs. Requirements 

o TestRuns vs. Resources 

 Releases 

o Releases vs. Requirement (*) 

o Releases vs. TestRuns 

 Resources 

o Resources vs. TestCases (*) 

o Resources vs. Testbeds (*) 

 Testbeds  

o Testbeds vs. Resources (*) 

(*) indicates that, for these combinations, you are able to manage the relationship between primary 

and secondary data directly.  

Please see figure 1 in section 1 which illustrates how data are crosswise related in multiple directions. 

Also, figure 2 in section 2.6 how the data model is designed, might be helpful for understanding the 

view concept 
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2.7 TestCenter data model 

We don’t need a technical knowledge of how TestCenter is implemented in order to use it, but it may 

be useful to have a basic understanding of the data model around which the application is designed. 

This can make it easier to see the “logic” of the user interface and user functions. 

 

Figure 2. TestCenter data model 

In figure 2 you see six core entities (Requirement, TestCase, TestRun, Release, Resource and Testbed). 

The thick solid line between indicates a many-to-many relationship between these two entities. This 

means the user can link/unlink records to each other in both ways. For example, any Requirement 

record can be linked to several TestCase records. Same time any TestCase record can be linked to 

several Requirement records. 

A dotted line indicates that there is no direct relation between the entities but instead an indirect 

relation can be established and presented in the user interface. However, the user cannot link/unlink 

records between the two entities. 

The solid line between TestRun and Release indicates a one-to-many relation. A TestRun can relate 

only to a specific Release, but several TestRuns can point to the same Release. Explained from a usage 

point of view; a specific product Release can be tested in many TestRuns, but a TestRun must be 

specific about what it is testing. You cannot test two different versions of the product in the same 

TestRun. 

TestResult is not an entity of the same sort as the other six. A TestResult represents a data record of a 

specific TestCase executed in a specific TestRun.  



TestCenter User Manual  2017-03-14     v0.81 

page 11 (20) 
 

3 Import and Export 

Import and export work with Excel formatted files.  

3.1 Import 

The import function is selected from the Tools menu.  

Data needs a correctly formatted in an Excel file. See example in below figure.  

 

The first line shall contain column headers. The Excel file must contain all columns corresponding to 

fields that are visible in form 1. The columns can vary somewhat between views. See example below. 

The first sample is for the Requirements, the second sample for the TestRuns. 1 

 

 

Data validation and error handling are rudimentary, so please make sure the Excel file is validated 

before you import it.  

 All Excel data cells should be formatted as text 

 All cells in the PID columns must contain a value. Other cells may be empty  

 Duplicate PID’s are not allowed 

3.2 Export 

Export function is selected from the Tool menu. One data entity (view) per Excel file. Make sure you 

have the correct view selected before you Export. Selecting export an Excel file is immediately created 

and downloaded to the standard downloads folder on the computer. 

                                                           
1 A good way to produce a correctly formatted Excel file is to export it from the application. 

PID Title Description Comment Type Priority Responsible Status Tag

1 Requirement #1 Description Req #1 Comment Req #1 Hardware 1 Magnus Confirmed #tag1

2 Requirement #2 Description Req #2 Comment Req #2 Hardware 1 Magnus Confirmed #tag1

3 Requirement #3 Description Req #3 Comment Req #3 Software 1 Magnus Confirmed #tag1

4 Requirement #4 Description Req #4 Comment Req #4 Software 1 Magnus Confirmed #tag1

5 Requirement #5 Description Req #5 Comment Req #5 Software 1 Magnus Confirmed #tag1

6 Requirement #6 Description Req #6 Comment Req #6 Software 1 Magnus Confirmed #tag1

7 Requirement #7 Description Req #7 Comment Req #7 Software 1 Magnus Confirmed #tag1

8 Requirement #8 Description Req #8 Comment Req #8 Software 1 Magnus Confirmed #tag1



TestCenter User Manual  2017-03-14     v0.81 

page 12 (20) 
 

4 Working with views 

Views represent the primary data. That is what’s in focus for the users’ operations. Primary data is 

presented and managed on the left side of the window. On the right side of the window is presented 

secondary data, which is data that can be related to the primary data.  

A view is selected by clicking the corresponding label on the top menu bar (see figure below).  

What to use as secondary data can be selected by clicking the corresponding label in the control panel 

in grid 2. In some cases, there is also possible to select what to present in grid 3.  

 

The control panels for grid 2 and grid 3 are buttons for managing the relation between primary and 

secondary data. Clicking on the Link button (grid 3) creates a relation between selected data, and 

clicking Unlink button (grid 2) removes the relation. 

Control panel for grid 3 also includes buttons for deleting and creating new records, so you don’t have 

to change the view to doing so. 

In some special situations, there are more operations available. See more about this under respective 

section. 

4.1 Requirements 

Requirements view is used when you want to create and administrated Requirements and see how 

requirements are related to other entity data. You can relate Requirements to: 

 TestCases (*) 

 TestRuns 

 Releases (*) 

Requirements are directly related to TestCases and to Releases. This means you can use Link and 

Unlink buttons for directly controlling the relationship.  

Requirements are not directly related to TestRuns, and you will not be able to link/unlink. TestRuns 

presented in grid 3 are those where all TestCases related to the selected Requirement are part of the 

TestRun. If only some of the TestCases are included, the TestRun will not be presented in grid 2. 
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4.2 TestCases 

TestCase view is used when you want to create and administrate TestCases and see how TestCases are 

related to other entity data. You can relate TestCases to: 

 Requirement (*) 

 TestRuns (*) 

 Resources (*) 

TestCases are directly related to all of these. This means you can use Link and Unlink buttons for 

directly controlling the relationship.  

4.2.1 TestCases vs. Requirements 

Often, there are more than one TestCases needed for validating a single Requirement. Also, a specific 

TestCase can be used for multiple Requirements.  

4.2.2 TestCases vs. Resources 

It is a god practice to specify what exact resources are being used for a particular TestCase. In the 

planning stage, this is useful for preparations beforehand TestRun execution. And after the test has 

been executed it is useful (needed?) as a record of under what exact circumstances the test has been 

performed. 

4.3 TestRuns 

TestRuns view is used when you want to create and administrate TestRuns and see how TestRuns are 

related to other entity data. TestRuns view is also used for executing tests and presenting test results. 

You can relate TestRuns to: 

 Requirement (*) 

 TestCases 

 Resources 

TestRuns are directly related to TestCases. Thus you can use Link and Unlink buttons for directly 

controlling the relationship. For other secondary data, you cannot link or unlink. 
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The TestRun view includes some additional controls in form 1: 

 Release – This is a reference to specify what is being tested. 

 TestDate – Date when TestRun is planned to be or has been executed. 

 Test user – User who performed the test execution (or is planned to). 

4.3.1 TestRuns vs. TestCase 

This view combination is used in several stages of the testing process: 

 Planning. TestRuns are synchronised to the development projects release plan. When 

TestRuns Requirement and TestCase analysis has been done, it is possible to analyse the scope 

for the TestRun and start preparations. 

 Executing. TestRuns are being executed and test results documented. 

 Test result analysis and reporting. When TestRuns has been executed, the test results and the 

projects’ status can be analysed in various ways.   

4.3.2 TestRuns vs. Requirement 

This view combination is used to see what requirements will be or has been tested in the selected 

TestRun(s). If the TestRuns has been executed, the test result is presented, in the leftmost column. 

Grid 2 presents the requirements that are related to the selected TestRun. To be considered “related”, 

all TestCases related to the Requirement has to be included in the TestRun. If only some TestCases are 

included in the TestRun, it will not show in grid 2. 

4.3.3 TestRuns vs. Resources 

This view combination is used to see all the resources that are needed in order to be able to execute 

the complete TestRuns. Related resources are based on what is linked to the individual TestCase. 

There is no possibility to add or remove resources in this view. 

4.3.4 Executing Tests 

Test execution is done with TestCases presented as secondary data. When this combination, there 

appears user controls for executing the test, each representing a certain test result. The eventual 

comment that the tester wants to keep a record of is documented in the comment field. 
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Following buttons are available: 

 OK – TestCase was successfully executed and the result was OK. 

 Fail – TestCase was successfully executed, but the result was not correct. Here it is 

recommended to document details of where and why the TestCase failed. 

 Not applicable – TestCase was not executed. This is used when the TestCase is not applicable 

to execute. For example, when a requirement has not been implemented according to plan, or 

if the TestCase is incorrectly part of the TestRun. The cause should be documented in the 

comment field. 

 Test not possible – TestCase was not executed. This is used it was not possible to execute the 

TestCase. For example, if there is a bug in preventing further execution, or if there is a missing 

resource for the TestCase. The cause should be documented in the comment field. 

 Clear – remove previous test result 

The test result is presented in the grid in the leftmost column. 

When the tester has completed all TestCases, he shall close it by clicking the “Save TestRun” button in 

grid 1 control panel. This locks the TestRun for further modification. 

Comments: 

 There is (currently) no support for linking documents to the TestCase result. If this is needed, 

the preferred way is to make a reference to the document in the comment field. 

 There is (currently) no support for issue tracking. Instead (in future), TestCenter will support 

integration with other issue tracking systems 

4.4 Releases 

Releases view is used when you want to define a Release plan, and see how Releases are related to 

other entity data. You can relate Releases to: 
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 Requirements (*) 

 TestRuns 

Releases are only directly related to Requirements. This means you can use Link and Unlink buttons 

for directly controlling the relationship. Releases are not directly related to TestRuns, so you are not 

able to link/unlink these entities.  

 

The TestRun view includes one additional control in form 1: 

 Release date – The planned date for when the release shall be delivered to the test project. 

Releases specify the exact object to be tested. Each record in grid 1 represented a specific delivery to 

the test team. The list in the grid makes up the “release plan” to which the development project and 

the test project has to be synchronised. It is important that time plans for respective activity are 

synchronised. 

4.5 Resources 

Resources view is used when you want to define a Release plan, and see how Resources are related to 

other entity data. You can relate Releases to: 

 TestCases (*) 

 Testbeds (*) 

Resources are directly related to both TestCases and Testbeds. This means you can use Link and Unlink 

buttons for directly controlling the relationship.  

Resources represent what is needed to be able to execute TestCases. A resource can be almost 

anything; an instrument, equipment, computer, some specific software, a specific set of test data or 

whatever else you would need for being able to execute the TestCase. It can also be seen as 

‘prerequisites’ for executing the TestCase.  
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4.6 Testbeds 

Testbeds represents a group of resources that are needed for a specific test situation. Some projects 

may have several test facilities; i.e. one for software testing, another for hardware testing, yet another 

for environment testing. This way you can easily keep records of each test facility’s needed inventory. 

Testbeds represents a group of resources that are needed for a specific test situation. Typically 

resources that are part of a specific test facility. 

In some projects situations, it can be convenient to define what is needed for a specific test facility.  

5 Subscription types 

TestCenter supports two types of subscription.  

 Personal – A user subscribes and pays for his subscription on an individual basis. Subscriptions 

are prepaid on a monthly basis.  

 Account – An organisation subscribes for a team of users that can be administrated and paid 

for in one common bill.  

This is primarily related to the billing handling but also have a small impact on how user roles and 

project sharing is working. 

6 User roles and access rights 

6.1 Access rights 

TestCenter has support for different levels of user access to the data. These “access rights” can be set 

to users according to their role in the system. TestCenter has following access rights: 

 Read only. The user can read all data but not add, change or delete anything. This is the lowest 

level of access right and default for all users (can not be configured). 

 Edit. The user can create, edit and delete any of entity data. 

 Share project. The user can share projects with other users. 

 Delete project. The user can delete projects. 

 Change user rights. The user can modify other users’ access rights. This is typically what an 

administrator would have. 

 Execute TestRun. The user can only change data related to executing TestRuns. Can edit test 

results and save TestRuns, but not edit any other data (like Requirements, TestCases, etc.). 

When starting a subscription (both personal and account), all users has all rights enabled by default.  

For users with a personal subscription, when sharing the project with other users, it is possible to set 

what access right the shared used shall be given. 

For account users, it is recommended that one person from the organisation is given the role of 

“Account administrator”, who then administrates access rights for all other users. 
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6.1.1 Data ownership 

No data “belongs” to any specific user. TestCenter doesn’t check what user is editing data. Anyone 

with the edit access right to the particular project can modify a record. This provides for flexibility but 

requires team discipline and coordination. 

6.2 User roles 

TestCenter doesn’t have a predefined user role model. Instead, organisations can define their own 

role model in a flexible way according to their own team structure. Following is an example how this 

can be done. 

Assume the organisation has following organisation structure: 

 System administrator, also responsible for billing/payments of the account 

 Project manager 

 Developer, programmer 

 Tester 

In this case, both system administrator can have all rights set. Developers can have Edit and Execute 

TestRuns. Testers can have only Execute TestRun set. 

7 Project Management 

 

Project Management is selected from the Project menu. Figure above show the left side window used 

for managing project information. On the right side, users are managed. 

In form 1 you can change projects name and description. You can also set project state: 

 Active – Normal state when the project is active.  

 Closed – The project is archived. It is still available for viewing, but no data can be altered. 

In the control panel above the grid you have various functions for the project: 



TestCenter User Manual  2017-03-14     v0.81 

page 19 (20) 
 

 Refresh. Reloads data from the database. 

 Delete. For deleting projects. (require write access) 

 Create new. For creating new projects. (require write access) 

 Switch. Change the current project. 

 Share Project. For sharing selected project to other users. The other user must be registered in 

the system. (require write access) 

7.1 Project ownership 

TestCenter doesn’t support the concept of project ownership. Instead, a project is considered an 

object to which users can be granted various access rights. Users don’t see any difference between a 

project that he has created himself or a project shared with him. The level of access rights can be 

different for different projects. 

Comment: The access right “Administrator” can be used as a sort of ownership control, as it gives that 

user full control of setting access rights for other users. 

7.2 Project sharing  

Projects sharing means letting another user get access to the selected project.  

The basic operation of the function is very similar to working in other views; on the left you have the 

projects and on the right side you have users. 

Left side 

Here is presented all project that user has access to. It makes no difference if it is a project that the 

user create himself or if it is a project shared by someone else. 

Right side 

The user that have access to the selected project (left side) are presented in grid 2, uses that do not in 

grid 3.  

With buttons Link and Unlink you control what users shall be linked (shared) to the selected project. 

Grid 1 presents  

Grid 2 presents all users that have access to the project selected in grid 1. This includes the current 

user. 

Grid 3 presents all users that don’t have access to the selected project but has access to any of the 

other projects presented in grid 1. Thus it is easy to see the full network of users one has relation to. 

In form 2, the selected user access rights are presented and can be managed. 

When starting a subscription the user have all rights enabled. When creating a new project the user 

gets full access right also to these.  

When sharing a project to another user, default is that the other user gets same access right as the 

user who is sharing. The sharing user can change what access right the other user shall be granted. It 
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is not possible to grant another user more access rights than one has himself, but it is possible to grant 

fewer access rights. 

7.3 Dropping out from a project 

In the situation that a user no longer want to take part of a particular project, he can unlink himself 

from the project. However, this is only possible if there is at least one other user linked to the project. 

 

8 Other topics 

8.1 Versioning 

TestCenter doesn't have versioning functionality. Instead, versioning can be managed by making a 

copy of the record being updated. The version identification can preferably be included in the title and 

additional Information in the description or comment field. 

8.2 Defect tracking 

TestCenter isn’t designed for advanced defect tracking support. The idea behind this design is that we 

believe many organisation already have a preferred choice for defect or issue tracking, and we don’t 

want the systems to be redundant. Instead, the solution is to support integration with other defect 

tracking systems. This feature is planned for the future. 

 

9 User settings….  

 

TO BE DESCRIBED…. 


